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Creating Web Pages for Depositories 
Rosalind Tedford, Wake Forest University 
Winston-Salem, NC 

History of Our Pages at Wake Forest 

Wake Forest is in a unique position currently because we have a partnership with IBM 
which, among other things, includes providing all incoming students with IBM Thinkpads. 
The library has signed on as the training center for the project so we have been provided 
with the latest technology in the form of desktop and laptop computers, and annual software 
upgrades. 

This was not always the case, however. Three years ago when I assumed the position I 
currently hold, Wake Forest had student labs which could access the Internet through 
Mosaic, but most of us in the library only had access through a gopher client. Web pages if 
done at all (and few were) were done using pico and typing in the HTML by hand. I had a 
friend who showed me my first HTML document and based on that, I designed a very basic 
home page for myself. Without direct Ethernet connections, however, I spent a lot of time 
running from computer to computer to test out my code. I gradually learned more code, how 
to do alignment, how to change font size, etc. and I began to consider designing a WWW 
page for our Government Documents department. 

The problem was, I didn’t have a computer with Internet access. Once I signed on to 
become a computer trainer for the pilot Thinkpad project in the summer of 1995, I received 
a laptop and got more training in Netscape and could finally begin to work on a page for our 
department. I was still typing in all the code for myself and the initial setup of our pages took 
me almost 2 months. As one of the few people in the library who knew HTML, I took it on 
myself to do the searching, coding and testing of every link and image. I did not have direct 
Ethernet access to the Internet in my office until winter of that year, and so I designed the 
pages on my hard drive and then would pass them to others to mount on our WWW server. 

Halfway into that academic year, however, we had our software upgraded to Windows95 
and direct Ethernet lines run into our offices. Then my career as a Web master was altered 
forever. I heard from a colleague that Microsoft had written a plug-in for Word which would 
write the code for you. I downloaded it for free from the Microsoft Web site 
(www.microsoft.com) and taught myself how to use it. It was a great improvement. Looking 
back now, it really didn’t do too terribly much, but it would write the code for images, font 
size, horizontal rules, etc. The things it could not do (background, color, centering) I would 



go back into the code and do manually. So while not perfect, it did save me a good deal of 
time in my first rewrite of our pages. The rewrite took me perhaps 2 weeks rather than two 
months, but then again I was only updating the pages, not creating them from scratch. I 
was, however, still dependent on others to mount the pages once I had created them on my 
hard drive. 

Then, last summer, we were upgraded to MSWord 7.0 and with that came a new version of 
Internet Assistant as a standard feature of the University’s software load. This version of 
Internet Assistant did alignment, color, backgrounds, and even tables. I used this to update 
our pages last fall and winter. About that same time, Netscape came out with Navigator 
Gold which was not only an Internet browser, but a Web page editor as well. I tested it out. 
There were some things I liked better about it and some things I liked better about Internet 
Assistant, so this spring when I redid our pages once again, I used them both. The nice 
thing about Netscape was that you didn’t have to have two big applications up and running 
at the same time, and on my 12Mb laptop this made things quicker. Netscape Gold could 
not, however, do tables which we used in our pages and so I switched back and forth 
between the two. I did gain a great advantage, however, when I got access to the Web 
server directly. This allows me now to update our pages at any time without relying on 
others. 

Now, however, with Netscape 3.0, the editing capabilities are greatly improved and at this 
point surpass Internet Assistant, and this is what I am currently using to edit my pages. 
Rumor has it that the new versions of both Word and Netscape will improve their Internet 
editing abilities even more. We will be upgraded to Office 97 this summer and I will learn 
more about the built in Web editing features of them then. As of now, however, I am 
committed to Netscape Gold 3.0 for my next round of updates which will be in May. 

The Current State of Web Pages at Wake Forest 

I currently spend a couple of hours each week at most adding links that I find out about from 
GOVDOC-L or through other sources. Then, each semester, I usually do a big overhaul of 
the pages which usually takes a week or more. I check all of our links myself, even though I 
know there are programs which check them for you. The couple of time I used these 
programs they took me more time than just checking them out by hand. I check not only to 
be sure the pages still exist, but that the information I linked to them for is still there. I also 
use these overhauls to change images, backgrounds, footers, etc. 

When I first began I wanted links to every site that existed, but as I have progressed and 
realized that there is no way I can keep up with all the sites, I let others do the work and link 
to large sites which keep up with things better than I. Why reinvent the wheel? Instead, we 
have concentrated our energies on our North Carolina resources page which has increased 
in size tenfold from its inception, because we feel that it is one place where we can provide 
a service not available in hundreds of other locations. 

Using Editors to Create and Maintain WWW Pages 

When Jennifer and I first discussed the idea of demonstrating HTML editors for you, I toyed 
with the idea of demonstrating both Internet Assistant and Netscape Gold, but rather than 



giving a cursory look at both, I have decided to concentrate only on Netscape Gold since 
this is what most libraries have access to and since it can perform all the functions 
previously done only by Internet Assistant. Most editors I have ever seen work essentially 
the same way, so in essence, "seen one seen them all." What I hope to do today is to give 
you a general idea of how editors work by showing you specifically how Netscape Gold 
works. If any of you are interested in Internet Assistant, I have put a link to my tutorial on 
our WWW page at WFU and this can be accessed at 

<http://www.wfu.edu/Library/govdoc/doclib.htm. 

Before I begin, however, I want to talk a little bit about editors in general, what they are and 
their benefits and drawbacks. Web editor refers to any of the myriad of programs which 
exist which write HTML code for you. All the user generally has to do is to click buttons, fill 
in boxes and select options and the editor will compile all of the information for you. If you 
save the document as an htm file, you can view it through Netscape or another browser. 
Generally, editors give you a way to view the code if you wish, but this is not a necessary 
step. 

First, the bad news. Editors are not of consistent quality. Some are better than others. 
There are hundreds out on the WWW free for the downloading and there are hundreds 
being sold commercially. With the advances in Netscape, however, I would not suggest 
spending any money on an editor UNLESS you have complicated CGI scripts, Java applets, 
or other complicated elements to incorporate into your page. For the standard Web page, 
Netscape Gold works beautifully. 

Another drawback to editors is that many people learn to design Web pages with them and 
never really learn HTML code. While this is seen by some as a good thing, (HTML is 
tedious), it can ultimately harm you because there are always things an editor does not do 
at all, or does not do right. If you know HTML, you can go into the code and fix these 
problems with a backslash or a simple command. Along the same lines, it is frequently the 
case that when you visit another WWW page that you see things you like. If you know 
HTML you can view the source code and see how they did it and then alter your own page 
to match. I would not suggest using editors instead of learning HTML, but rather as an 
accessory to HTML knowledge. 

On the positive side, however, editors save you lots of time, especially if you have large 
pages to create. You can copy and paste text and images into them and the code is written 
for you. This saves you the time of hunting through your code for the one tag which you 
forgot to add in. Pointing and clicking at boxes and filing in blanks is also quicker than typing 
everything in. Changing your background color, for example, is as easy as finding a new 
color on the palette and clicking on it--no 6-digit color code needed. For those familiar with 
HTML, I think editors are great. 

Creating WWW Documents with Netscape 3.0 

Preliminary Steps 



1. To create a new document, choose ‘New Document – Blank’ from the File menu. 
Skip to step 3. 

2. To edit an existing page, go to the page and click the edit button. You will see a 
dialog box which will ask you to save the WWW page (and all the images associated 
with it) onto your hard drive. You cannot edit directly on the WWW server! 

3. Save your page (even though you haven’t done anything yet). For those of you who 
created a new blank page, you must choose ‘Save As’ from the ‘File’ menu. Those of 
you who are using another page to work from just chose to save in step 2. 

Time to Edit! 

1. You will see your page laid out in the Netscape editor window. You can type directly 
into the window, just like with a word processor. 

2. To change the color scheme or add a background image, go to the Document menu 
and choose Properties. There is a section there dealing with color. 

3. Formatting is simple from the Netscape editor’s toolbar. Put the mouse cursor over a 
button to find out what it does. Many of the buttons, such as bullets, numbers, 
indention and justification look just as they do in Microsoft Word. 

4. Font size is controlled with the Increase and Decrease font size buttons. Next to 
them are the bold and italic options, as well as color. To use paragraph formats such 
as Headings, use the drop down paragraph format menu. 

5. To add a link, choose the picture of a link. You will be prompted for the URL 
(address) and the title of your new link. To make an image into a link, select the 
image and then click the link button. 

6. Adding a target, or bookmark, allows you to navigate within a page. First, you add a 
target to the point you want people to navigate to by highlighting the text or image 
which is to become the target. Then you click the target button. You will be prompted 
to name the target. Then when you create a link, you can send the link directly to the 
target location by selecting it from the targets box at the bottom. 

7. To add an image, choose the image button. You will be prompted to enter or browse 
for the image file, and be given options for how to wrap text around your image or 
how to deal with a text-only display. Note: You cannot see text wrapping in the 
editing window. You must load your page in the Browser window to see text wrap 
around an image. 

8. To add a horizontal rule, use the horizontal rule button: This will insert the line all the 
way across the page. The default height is 2 pixels. To alter either of these, click on 
the line and choose "Horizontal line," from Properties menu. 

9. To add a table, click the table button. You will be given spaces to define the size of 
the table first and then once this has been defined, you can go to the Properties 
menu, choose "Table" and define more elements of your table including colors, text 
alignment within cells, and many other options. 

10. For items not available in Netscape Gold, you can insert the HTML tag directly into 
your document by going to the Insert menu and choosing "HTML Tag." 

11. To see what your page will look like on the WWW, you can preview it through 
Netscape. Just click the Netscape button on the toolbar and you will be prompted to 
save your document. Once saved, a Netscape window will open and VOILA! Your 
document as it will look on the WWW. 


